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改訂履歴

次の表に、 この文書の改訂履歴を示します。

 

日付 バージョ ン 内容

2013 年 11 月 12 日 1.0 初版

2014 年 3 月 18 日 1.0.1 図 2-1 および図 2-2 への参照を修正。 表 2-1 の SW16 の設定 ( 位置 4) を修正。
PDF のブッ クマークに章番号を追加、 およびフ ィードバッ ク  ボタンを追加。
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第 1 章 : はじめに

第 1 章

はじめに

概要
Zynq®-7000 All Programmable SoC (AP SoC) は、 非公開キー暗号 (AES/HMAC) と公開キー暗号 (RSA) を提供します。
これによって、機密性の高いソフ ト ウェアを暗号化したり、Zynq-7000 AP SoC へロード されるソフ ト ウェアの認証を
ト ラス ト  チェーン (信頼の連鎖) で行う こ とができます。 ト ラス ト  チェーンを使用するブート  プロセスでは、 敵対者
によるソフ ト ウェアの改ざんが行われていないこSとが保証されます。 機密性の高いソフ ト ウェアは、 暗号化するこ
とで解読不可となり信頼性が向上します。

AES は非公開キーを使用します。 RSA は Zynq-7000 AP SoC 内の公開キーを使用し、 このキーは必要に応じて何度で
も変更でき、同じイ メージ内のパーティシ ョ ンに対しても同様です。敵対者がキーを攻撃する時間を制限するために、
暗号キーは変更する必要があ り ます。

Zynq-7000 AP SoC のセキュ リ テ ィ機能はプログラマブル リ ソースを使用しません。 したがって、 Zynq-7000 AP SoC
内のセキュ リティ機能を使用する際のコス トは、セキュア ブートの使用法を学ぶための時間く らいです。このスター
ト アップ ガイ ドでは、 セキュア ブートの使用法を ZC702 評価ボードを用いて説明します。 非セキュア ブート とセ
キュア ブートでは、 同じザイ リ ンクス  ツールを使用するため、 ツール フローの変更はあ り ません。 14.6 リ リースの
場合、 セキュア ブート機能には Bootgen をコマンド  ラ イン ツールと して使用する必要があ り ます。

このユーザー ガイ ドに付属する参照システムは、 次のリ ンクから入手可能です。

https://secure.xilinx.com/webreg/clickthrough.do?cid=345331

このユーザー ガイ ドの内容は次のとおりです。

• 第 2 章 「ZC702 評価ボードのセッ ト アップ」

• 第 3 章 「AES/RSA キーの生成およびプログラ ミ ング」

• 第 4 章 「Bootgen イ メージ フォーマッ ト  ファ イルの作成」

• 第 5 章 「高度なキー管理オプシ ョ ン」

• 第 6 章 「マルチブート 」

• 第 7 章 「データ  パーティシ ョ ンのローディング」

• 第 8 章 「認証証明のユーザー定義フ ィールドを使用」

TRD に関するその他の情報は、 『Zynq-7000 All Programmable SoC ZC702 評価キッ トおよびビデオ/画像処理キッ ト  ス
タート アップ ガイ ド』 (UG926) [参照 1] を参照してください。

セキュア ブートに関するその他の情報は、『Zynq-7000 All Programmable SoC のセキュア ブート  (XAPP1175)』 [参照 2]
を参照してください。

Send Feedback

http://japan.xilinx.com
https://secure.xilinx.com/webreg/clickthrough.do?cid=345331
http://japan.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1025&Title=Zynq-7000%20All%20Programmable%20SoC%20%26%2312398%3B%26%2312475%3B%26%2312461%3B%26%2312517%3B%26%2312450%3B%20%26%2312502%3B%26%2312540%3B%26%2312488%3B%20%26%2312473%3B%26%2312479%3B%26%2312540%3B%26%2312488%3B%26%2312450%3B%26%2312483%3B%26%2312503%3B%20%26%2312460%3B%26%2312452%3B%26%2312489%3B&releaseVersion=1.0.1&docPage=5


第 2 章 : ZC702 評価ボードのセッ トアップ
第 2 章

ZC702 評価ボードのセッ トアップ

概要
この章では、 ZC702 評価ボードのセッ ト アップ方法について説明します。

注記 : ZC702 ボードの全機能の説明は、 『Zynq-7000 XC7Z020 All Programmable SoC 向け ZC702 評価ボード   ユーザー
ガイ ド』 (UG850) [参照 3] を参照してください。

ZC702 のセッ トアップ要件
ZC702 評価ボードのセッ ト アップに必要なものを次に示します。

• ハードウェアのセッ ト アップ : 

° ZC702 評価ボード  (XC7Z020 CLG484-1 搭載)

° USB Type-A/Mini-B ケーブル (UART 通信用)

° AC 電源アダプター (12 VDC)

• Windows ソフ ト ウェアおよびド ライバーのセッ ト アップ : 

° Tera Term Pro (または同等の) 端末プログラム (このプログラムはすでにインス トールされている場合があ り
ます。 詳細は、 Tera Term のウェブサイ ト を参照してください。 )

° Silicon Laboratories 社製 USB-UART ド ラ イバー (Silicon Laboratories 社の USB-UART ド ラ イバー ダウン
ロード  サイ ト からダウンロード可能です。 このプログラムはすでにインス トールされている場合があ り ま
す。 )

ZC702 のセッ トアップ要件

ZC702 ボードのジャンパーとスイ ッチのデフォルト設定を図 2-1 および表 2-1 に示します。
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第 2 章 : ZC702 評価ボードのセッ トアップ
Quad SPI デバイスからブートする場合、 図 2-1 のよ うに SW16 スイ ッチを設定します。 ポジシ ョ ン 1、 2、 3、 および
5 を右にし、 ポジシ ョ ン 4 を左にします。

X-Ref Target - Figure 2-1

図 2-1 : Quad SPI モードでブートする場合のモード  スイッチ設定

UG1025_c2_01_090313

表 2-1 : ZC702 評価ボードのスイッチ設定

スイッチ ポジシ ョ ン 設定

SW10

(JTAG チェーン入力選択用の 2 個の DIP スイ ッチ)

1 オフ

2 オン

SW12

(2 個の DIP スイ ッチ)

1 オフ

2 オフ

SW15

(2 個の DIP スイ ッチ)

1 オフ

2 オフ

SW16

(5 個の DIP スイ ッチ)

1 右

2 右

3 右

4 左

5 右

SW11

(電源スライ ド  スイ ッチ)
オフ 下シフ ト
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第 2 章 : ZC702 評価ボードのセッ トアップ
ハードウェアのセッ トアップ
このセクシ ョ ンでは、 ハード ウェア セッ ト アップの手順について説明します。

1. SW16 モード  スイ ッチを図 2-1 のよ うに設定します。

2. ZC702 ボードの電源をオフにした状態 (図 2-2 の SW11 は下) で、 USB Mini-B ケーブルを ZC702 ボード上の
USB-UART と表示されている  mini-USB ポート  J17 へ接続し、 も う一方を PC 側の空いている  USB ポートへ接続
します (図 2-2)。

3. 電源ケーブルを接続します。

4. ZC702 ボードの電源をオンにします (SW11 スイ ッチを上にシフ ト )。

USB-UART ド ライバーのインストール 
1. ダウンロード した実行可能な UART-USB ド ラ イバー ファ イル (6 ページの 「ZC702 のセッ ト アップ要件」 に記

載) を実行します。この実行ファ イルを実行する こ とによって、ホス ト  PC との USB - UART 間通信が可能にな
り ます。 このド ラ イバーは、 ボードに電源が投入される と自動的にダウンロード と実行を開始します。 また、
このド ラ イバーは、 Silicon Laboratories 社の USB-UART ド ラ イバー ダウンロード  サイ ト からダウンロードで
きます。

X-Ref Target - Figure 2-2

図 2-2 : UART と電源ケーブルを接続する ZC702 
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第 2 章 : ZC702 評価ボードのセッ トアップ
2. [デバイス  マネージャー ] で USB-UART 間の接続を既知の COM ポートおよびボー レートに設定します。

a. Windows 7 の場合、 [スタート ] メニューを左ク リ ッ ク して、 [コン ト ロール パネル] を選択します。

b. [デバイス  マネージャー ] を選択します。

c. リ ス トの中から  Silicon Labs 社製のデバイスを右ク リ ッ ク して、 [プロパティ ] を選択します。

d. [ポートの設定] タブをク リ ッ ク します。 [詳細設定] をク リ ッ ク します。

e. COM1 ～ COM4 の中で有効な COM ポート を選択します。これでコンピューターがポートの割り当てを記憶
するため、 ボードのシ リ アル UART ポート をプラグインするたびに再度割り当てる必要はあ り ません。

f. ビッ ト /秒 ＝ 115200、データ  ビッ ト  ＝ 8、パリ ティ  ＝ なし、 ス ト ップ ビッ ト  ＝ 1、およびフロー制御 ＝ な
し  に設定します。 [OK] をク リ ッ ク します。

注記 : 手順および図は、 Windows XP または Windows 7 ホス ト  PC を使用した場合を示しています。

X-Ref Target - Figure 2-3

図 2-3 : UART ケーブル ド ライバーのインストール
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第 2 章 : ZC702 評価ボードのセッ トアップ
図 2-4 ～図 2-6 は、 USB-UART ポートの設定手順を示しています。

X-Ref Target - Figure 2-4

図 2-4 : ド ライバーの設定
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X-Ref Target - Figure 2-5

図 2-5 : UART の [ポートの設定] タブ
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第 2 章 : ZC702 評価ボードのセッ トアップ
非セキュア TRD アプリケーシ ョ ンの実行
1. インス トール済みの Tera Term または同等の端末プログラムを開始し、 次のよ うに設定します。

ビッ ト /秒 = 115200、 データ  ビッ ト = 8、 パリ ティ = なし、 ス ト ップ ビッ ト = 1、 フロー制御 = なし

2. ZC702 評価ボード上でブート  モード  スイ ッチ (J16) を  JTAG モードにします。

3. [SDK] → [Xilinx Tools] → [Program Flash] を呼び出して、
ug1025/zc702_linux_trd/ready_for_download/zc702_linux_trd_ns.mcs を参照します。 オフセッ
トに 「0x0 」 と入力して、 [Finish] をク リ ッ ク します。 QSPI がプログラムされた後に電源を切り ます。

X-Ref Target - Figure 2-6

図 2-6 : COM ポートの選択 (COM1 ～ COM4)
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第 2 章 : ZC702 評価ボードのセッ トアップ
4. 電源を入れて、 QSPI モードで TRD をブート します。 図 2-7 に、 TRD のブート を示します。

ZC702 ボードに関する詳細情報は、『Zynq-7000 XC7Z020 All Programmable SoC 向け ZC702 評価ボード   ユーザー ガイ
ド』 (UG850) [参照 3] を参照して ください。 図 2-1 に、 工場出荷時の ZC702 ボードのジャンパーおよびスイ ッチの設
定が示されています。 スイ ッチとジャンパーのデフォルト設定一覧は表 2-1 を参照してください。

ZC702 評価キッ トの最新情報については、 Zynq-7000 All Programmable SoC ZC702 評価キッ トの資料ウェブサイ ト を
参照してください。ZC702 ボードを使用した基本的なハードウェアおよびソフ ト ウェア フローの詳細は、『Zynq-7000
All Programmable SoC : コンセプ ト、 ツール、 テクニッ ク  ガイ ド』 (UG873) [参照 4] を参照してください。 その他の情
報は、 Zynq-7000 AP SoC の資料ウェブサイ ト を参照して ください。

X-Ref Target - Figure 2-7

図 2-7 : zc702_linux_trd のブート
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第 3 章 : AES/RSA キーの生成およびプログラ ミング
第 3 章

AES/RSA キーの生成およびプログラ ミング

概要
この章では、キーの生成およびプログラ ミ ングについて説明します。図 3-1 に、 こ こで説明する ト ピッ クを示します。

Zynq®-7000 All Programmable SoC (AP SoC) で使用される暗号キーを次に示します。

• 256 ビッ トの AES 暗号キー

• 256 ビッ トの HMAC 暗号キー

• RSA プライマ リ非公開キー (PSK)

• RSA プライマ リ公開キー (PPK)

• RSA セカンダ リ非公開キー (SSK)

• RSA セカンダ リ公開キー (SPK)

推奨されるセキュア ブート  フローを実行するため、AES および RSA キーを生成して Zynq AP SoC 内にプログラムし
て ください。 AES キーは、 Bootgen を使用して生成します。 AES キーは、 バッテ リ  バッ クアップ RAM (BBRAM) ま
たは eFUSE にプログラムできます。 BBRAM は、 再プログラム可能でゼロ  ク リ アなメモ リです。 eFUSE は 1 回のみ
プログラム可能 (OTP) です。

Zynq AP SoC では、 プライマ リ  RSA キーを使用してセカンダ リ  キーを認証します。 そしてセカンダ リ  キーを使用し
てパーテ ィ シ ョ ン (ELF、 BIT フ ァ イルなど) を認証します。 RSA プラ イマ リおよびセカンダ リ  キーの生成には、
OpenSSL を使用します。OpenSSL は入手が簡単と言う理由で使用していますが、その他の方法でも可能です。OpenSSL
で生成される  RSA キーは、非公開キーと公開キーの 2 つです。公開キーは、非公開キーのサブセッ ト とな り ます。セ
キュ リ テ ィ上、 非公開キーの保護が非常に重要です。 RSA の場合、 非公開キーを使用して製造サイ ト で各パーティ
シ ョ ンに署名し、 その署名を検証するために、 Zynq AP SoC エンベデッ ド  デバイスに公開キーがプログラムされま
す。 フ ィールドにあるエンベデッ ド  デバイスには非公開の RSA キーが含まれていないため安全です。

このスタート アップ ガイ ドでは、iMPACT を使用してデバイスに AES キーがプログラムされます。RSA セキュ リ ティ
は、ザイ リ ンクスのセキュア キー ド ラ イバーを使用してデバイスにプログラムされます。 セキュア キー ド ラ イバー
は、 AES キーをプログラムできます。

X-Ref Target - Figure 3-1

図 3-1 : キーの生成およびプログラ ミング
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第 3 章 : AES/RSA キーの生成およびプログラ ミング
AES キーの生成およびプログラム
次の手順で Bootgen を使用して AES キーを生成します。

1. 次のコマンドを使用して generate_aeskey.bif ファ イルを生成します。

generate_aeskey:
{
[aeskeyfile] bbram.nky
[bootloader, encryption=aes] fsbl.elf
}

2. 次の Bootgen コマンドを使用して AES キーを生成します。

bootgen -image generate_aeskey.bif -o temp.mcs -encrypt bbram

指定した AES キーがない場合は、 Bootgen が generate_aeskey.bif 内にある名前 (この場合は bbram.nky)
を使用してキーを生成します。

3. AES キーをプログラムするために、 iMPACT を起動します。 Linux の場合は、 impact & を実行します。 Windows
の場合は、 スタート  メニューから  [ISE Design Suite 14.6] → [ISE Design Tools] → [64-Bit Tools] → [iMPACT] を選
択します。 プロジェ ク ト  フ ァ イルを保存する指示画面が表示された場合は [No] を ク リ ッ ク し ます。 新しい
iMPACT プロジェク トのダイアログ ボッ クスが表示された場合は [Cancel] をク リ ッ ク します。

4. [iMPACT Flows] ウ ィンド ウで Boundary Scan をダブルク リ ッ ク します。 右ク リ ッ ク して Initialize Chain を選択し
ます。 JTAG チェーンに xc7z020 FPGA の ARM コアが 1 つしか表示されない場合は、 ブート  モード  スイ ッチ
を JTAG に変更してチェーンを再び初期化します。コンフ ィギュレーシ ョ ン ファ イルの割り当て指示画面が表示
されたら  [Yes] をク リ ッ ク します。

5. DAP が緑色表示している と きに [Bypass] をク リ ッ ク します。xc7z020 を選択して、 [Assign New Configuration File]
ダイアログ ボッ クスに手順 1 で生成した AES キーを 入力します。 [Device Programming Properties] が表示された
場合は [Cancel] をク リ ッ ク します。
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第 3 章 : AES/RSA キーの生成およびプログラ ミング
図 3-2 に、 iMPACT の JTAG チェーンを示します。

6. 図 3-3 に示すよ うに、 iMPACT を使用して BBRAM キーをプログラムします。 [ZC7Z020] を右ク リ ッ ク して、
[Program] をク リ ッ ク します。 iMPACT では eFUSE キーもプログラムできます。 eFUSE キーと  BBRAM キーは両
方と も  Zynq AP SoC へプログラムできます。 Bootgen で -encrypt コマンド  オプシ ョ ンの引数 efuse | bbram を使用
して、 使用するキーを指定します。 Bootgen がイ メージの Boot Header 領域にキー ソースを書き込みます。 電源
投入時に BootROM コードが Boot Header を読み取り、 使用するキー ソースを判断します。

eFUSE の制御も  [iMPACT Processes] ウ ィンド ウの [Available Operations] を使用してプログラムできます。 eFUSE 制御
レジスタは、 キーの切り替えを制限したり、 JTAG ポート を永久的に無効にするなどの機能に使用されます。

X-Ref Target - Figure 3-2

図 3-2 : iMPACT - 連結されたチェーンの検出
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RSA キーの生成
このセクシ ョ ンでは、 プライマ リおよびセカンダ リ  RSA キーを生成します。 これらのキーを使用して、 プライマ リ
公開キーのハッシュが生成されます。

1. このユーザー ガイ ドでは、 OpenSSL を使用して RSA キーを生成します。 (RSA キーの生成手段はほかにもあ り
ます。 ) プライマ リおよびセカンダ リ非公開 RSA キーは、 次の OpenSSL コマンドを使用して生成されます。

openssl genrsa -out psk.pk1 2048
openssl genrsa -out ssk.pk1 2048

RSA の場合、 公開キーは非公開キーの中に含まれます。 次の OpenSSL コマンドを使用して、 非公開キーから公
開キーを抽出します。

openssl rsa -pubout -in psk.pk1 -out ppk.pub
openssl rsa -pubout -in ssk.pk1 -out spk.pub

X-Ref Target - Figure 3-3

図 3-3 : iMPACT を使用して BBRAM キーをプログラム
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2. プライマ リ公開キー (PPK) のハッシュを生成します。 openssl を使用して RSA キーを生成した後、 Bootgen を使
用して PPK のハッシュを生成します。 次のコマンドを使用して gen_hash_ppk.bif を生成します。

gen_hash_ppk:
{
[pskfile] psk.pk1
[sskfile] ssk.pk1
[bootloader, authentication=rsa] fsbl.elf
}

3. 次を実行します。

bootgen -image gen_hash_ppk.bif -efuseppkbits hash_ppk.txt

hash_ppk.txt ファ イルに PPK のハッシュが含まれます。

セキュア キー ド ライバーを生成して RSA 機能を有
効化
RSA を使用するには、 PS eFUSE アレイに RSA Enable 制御ビッ ト と  PPK のハッシュをプログラムする必要があ り
ます。 これを行うには、 ソフ ト ウェア開発キッ ト  (SDK) を使用してセキュア  キー ド ラ イバー ソフ ト ウェアのプロ
ジェ ク ト を作成します。 このプロジェ ク トは、ug1025/zc702_secure_driver ディ レク ト リにあ り ます。セキュア  キー
ド ラ イバーの機能は、xilskey_efuse_example.c および xilskey_input.h ファ イルを編集して操作します。

RSA を有効にして PPK のハッシュをプログラムするには、 xilskey_input.h ファ イルを編集して PS eFUSE、 PL
eFUSE、 またはそれらの両方をプログラムします。 eFUSE は OTP であるため、 すでにプログラム済みの場合には、
PPK ハッシュの読み取りのみ可能となるよ うに xilskey_efuse_example.c ファ イルを編集できます。

次のよ うに xilskey_input.h ファ イルを編集します。

1. XSK_EFUSEPS_DRIVER を定義します。

2. コ メン ト を使用して XSK_EFSUSEPL_DRIVER を無効にします。

3. hash_ppk.txt から  XSK_EFUSEPS_RSA_KEY_HASH_VALUE に PPK ハッシュをコピーします。

4. XSK_EFUSEPS_ENABLE_RSA_KEY_HASH を TRUE に設定します。

5. XSK_EFUSEPS_ENABLE_RSA_AUTH を TRUE に設定します。
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SDK を使用してセキュア  キー ド ラ イバーをコンパイルします。 Linux の場合、 xsdk & を実行して SDK を起動しま
す。 Windows の場合、 Xilinx SDK 2013.2 をダブルク リ ッ クするか、 [スタート ] → [ISE Design Suite 14.6] → [EDK] →
[Xilinx Software Development Kit] を選択して SDK を起動します。 図 3-4 のよ うにワークスペースを選択します。

X-Ref Target - Figure 3-4

図 3-4 : セキュア キー ド ライバーのワークスペースを選択
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6. 図 3-5 のよ うに新しいアプリ ケーシ ョ ン プロジェク ト を作成します。 [Project name] に 「secure_key_driver」 と入
力します。 その他のオプシ ョ ンはデフォルト値のままで使用します。 [Next] をク リ ッ ク します。

X-Ref Target - Figure 3-5

図 3-5 : セキュア キー ド ライバーの作成
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7. 図 3-6 のよ うに [Empty Application] を選択して、 ダイアログ ボッ クスが表示されるたら、 secure_key_driver プロ
ジェク ト を指定して [Finish] をク リ ッ ク します。

X-Ref Target - Figure 3-6

図 3-6 : 空のアプリケーシ ョ ンの作成
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8. 図 3-7 のよ うに [secure_key_driver_bsp] を右ク リ ッ ク して、 [Board Support Package Settings] をク リ ッ ク します。

X-Ref Target - Figure 3-7

図 3-7 : ボード  サポート  パッケージの設定
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9. 図 3-8 のよ うに [xilskey library] を選択して、 ボード  サポート  パッケージ (BSP) を再構築します。 [OK] をク リ ッ
ク します。

X-Ref Target - Figure 3-8

図 3-8 : セキュア キー ライブラリの選択
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10. xilskey ライブラ リは、 secure_key_driver_bsp/ps7_cortexa9_0/lib の下にコンパイルされ、 [Project Explorer] ウ ィンド
ウに表示されます。 図 3-9 を参照してください。

X-Ref Target - Figure 3-9

図 3-9 : コンパイルされた xilskey ライブラリ
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11. secure_key_driver を選択し、 [File] → [Import] → [General Files] を選択して、 アプ リ ケーシ ョ ン プロジェク トに
xilskey_efuse_example.c および xilskey_input.h をインポート します。secure_key_driver プロジェク ト
を選択して、 [Project] → [Build Project] を実行します。 図 3-10 に、 コンパイルされた secure_key_driver プロジェ
ク ト を示します。

セキュア キー ド ライバーを実行して RSA 機能を有
効化
セキュア キー ド ラ イバーは、 いかなるブート  モードでも実行できます。 最もシンプルな方法は JTAG であ り、 次の
XMD コマンドを使用します。 コマンド  プロンプ トに 「xmd」 と入力するか、 SDK で [Xilinx Tools] → [XMD Console]
をク リ ッ ク して XMD コンソールを開きます。

connect arm hw
dow fsbl.elf
con
stop
dow secure_key_driver.elf

X-Ref Target - Figure 3-10

図 3-10 : コンパイルされたセキュア キー ド ライバー プロジェク ト
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con
stop

読み取り可能に設定して secure_key_driver をコンパイルする と、 通信端末を開いて PPK のハッシュ値を確認できま
す。
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第 4 章

Bootgen イメージ フォーマッ ト  ファイルの作成

概要
Bootgen を使用して、 Zynq®-7000 All Programmable SoC (AP SoC) の起動に使用されるファ イル イ メージを生成し
ます。Bootgen へ入力されるファ イルは、イ メージ内に含まれるパーティシ ョ ンを リ ス ト した Bootgen Image Format
(BIF) ファ イルです。 パーティシ ョ ン とは、 イ メージを構成する ソフ ト ウェア、 データ、 およびビッ ト ス ト リーム
ファ イルです。 たとえば、 TRD のパーティシ ョ ンは、 fsbl.elf、 system.bit、 u-boot.elf、 uImage.bin、
uramdisk.image.gz、 devicetree.dtb、 および sobel_cmd.elf です。

BIF では、属性を使用してパーティシ ョ ンの暗号化 [encryption] や認証 [authentication] を指定します。 また、不揮発性
メモ リ  (NVM) のオフセッ ト  アドレス  [offset] やダブルデータレート  (DDR) メモ リのロード  アドレス  [load] を指定す
る場合にも属性を使用します。

Bootgen は、 イ メージ ファ イルを MCS フォーマッ ト または BIN フォーマッ トで出力します。 Zynq Flash Programmer
を使用してクワッ ド  シ リ アル ペリ フェラル インターフェイス  (QSPI) へ書き込みを実行する場合は、Intel MCS フォー
マッ ト を使用します。 U-Boot を使用して QSPI をプログラムする場合や SD ブート  モードを使用する場合には、 BIN
フォーマッ ト を使用します。

14.6 では、 RSA およびパーティシ ョ ン ベースで暗号/認証を指定する機能は、 コマンド  ラインで Bootgen を使用する
場合のみ有効です。 14.6 の Bootgen GUI では、 セキュ リ テ ィ機能のサポー ト に制限があ り ます。 また、 14.6 では、
Bootgen コマンド  ラ インは Linux 上でのみ利用できます。

TRD を安全に起動
TRD を安全に起動するために使用される  BIF を次に示します。

trd_image:{

[aeskeyfile] bbram.nky
[pskfile] psk.pk1
[sskfile] ssk.pk1
[bootloader, encryption=aes, authentication=rsa] fsbl.elf
[encrytion=aes, authentication=rsa] system.bit
[authentication=rsa] u-boot.elf
[authentication=rsa, load= 0x3000000, offset=0x100000] uImage.bin
[authentication=rsa, load=0x2A000000, offset=0x600000] devicetree.dtb
[authentication=rsa, load=0x2000000, offset=0x620000] uramdisk.image.gz
[encryption=aes, authentication=rsa] sobel_cmd.elf

この BIF では、 ト ラス ト  チェーンを使用してソフ ト ウェアがロード されるよ うに、 すべてのパーティシ ョ ンが認証
されます。FSBL は暗号化されます。system.bit や sobel_cmd.elf などの機密性の高いパーティシ ョ ンは暗号化
されますが、 U-Boot や Linux などのオープン ソース  パーティシ ョ ンは暗号化されません。
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ビッ ト ス ト リーム パーティシ ョ ンが含まれているため、この BIF を使用して作成されたイ メージは大きすぎて ZC702
QSPI 内 (16MB) に収ま り ません。 BIF から  4.4MB の system.bit を削除する と格納可能になり ます。

[aeskeyfile]、 [pskfile]、 および [sskfile] 属性で指定した暗号キーの生成については、 第 3 章を参照してください。

この BIF では、 FSBL が指定された DDR アドレスへパーティシ ョ ンをロードできるよ うに、 [offset] 属性と  [load] 属
性を使用します。ほとんどのシステムでは、U-Boot を使用してパーティシ ョ ンをロード します。 14.6 リ リースの時点
では、 パーティシ ョ ンの認証に使用される  RSA ラ イブラ リが U-Boot に含まれていません。 このため、 FSBL を使用
してパーティシ ョ ンを認証/ロード します。すべてのパーティシ ョ ンが FSBL で認証されるフローをサポートするため
に、 U-Boot zynq_common.h は変更されています。

注記 : U-Boot の認証機能は、 14.7 リ リースでサポート される予定です。

ト ラス ト  チェーンを使用してデバイスがブート されるよ う、 すべてのパーティシ ョ ンが認証される必要があ り ます。
つま り、 各パーティシ ョ ンはロード前に認証されます。 ほとんどの場合、 すべてのパーティシ ョ ンは暗号化されてい
ません。 暗号は機密性を与えるため、 機密情報を含むパーテ ィシ ョ ンは暗号化すべきです。 一般的には、 Linux や
U-Boot などのオープン ソース  パーティシ ョ ンを暗号化するこ とはあま り意味がないと考えられています。 暗号化は
ブート時間を増加する可能性があ り ますが、 これまでにテス ト した NVM コンフ ィギュレーシ ョ ンでは、 セキュア
ブート と非セキュア ブートのブート時間に差はあ り ません。

AES は既知のプレーン テキス ト攻撃に対して脆弱ではあ り ませんが、それ以外の攻撃を受ける可能性があるため、必
要ない場合に暗号化を使用すべきではあ り ません。 暗号化は機密情報を保護するために使用してください。

QSPI モードで TRD を安全に起動するには、 次の手順を実行します。

1. 第 2 章で説明したとおりに、 ZC702 評価ボードを設定します。

2. 第 2 章で説明したとおりに、 Tera Term を設定します。

3. UG1025/zc702_secure_key_driver/SDK ディ レク ト リへ移動します。 第 3 章で説明したとおりに
secure_key_driver.elf プロジェク ト を作成します。PS RSA_Enable および PPK eFUSE のハッシュをプログ
ラムするために、 次の xmd コマンドを実行します。

connect arm hw
dow fsbl.elf
con 
stop
dow secure_key_driver.elf
con
exit

4. ug1025/zc702_linux_trd ディ レク ト リへ移動します。 このプロジェク トの BIF 機能を確認する場合は、
zc702_linux_trd.bif を開いて属性を確認します。 次を実行して TRD イ メージを生成します。

bootgen -image zc702_linux_trd.bif -o zc702_linux_trd.mcs -encrypt bbram

注記 : SDK 14.6 リ リースの場合、 Bootgen コマンド  ラ インは Linux 上で実行する必要があ り ます。 Windows は、
SDK 14.7 でサポート される予定です。

5. Linux の場合、 xsdk & を実行して SDK を起動します。 ワークスペースを  ug1025/zc702_linux_trd/SDK に指定
します。

6. SDK で [Xilinx Tools] → [Program Flash] をク リ ッ ク します。 電源を切り ます。

7. 次のイ メージを指定します。

ug1025/zc702_linux_trd/zc702_linux_trd.mcs

前に述べたとおり、 この MCS イ メージには TRD ビッ ト ス ト リームが含まれていません。 TRD をブートするに
は、 ビッ ト ス ト リームを含む BIN イ メージを生成して、 SD モードでブート します。

8. J25 を 1 へ移動、または評価ボードが SW16 を使用している場合にはスイ ッチ 4 を 1 へ移動して、ZC702 評価ボー
ド上のブート  モードを QSPI に変更します。
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9. 電源を一旦切ってから再度オンにします。Petalinux プロンプ ト画面で Zynq AP SoC のブート を検証します。 ログ
インには、 ユーザー名 root、 パスワード  root を使用します。 図 4-1 に、 予想される  TRD 出力を示します。

10. 非セキュアとセキュアのブート時間を比較するため、 非セキュア ブート用に QSPI へ
zc702_linux_trd_ns.mcs をプログラムして手順 7 ～手順 9 を繰り返します。 電源を投入してから、 通信端
末に 「zynq>」 と表示されるまでの時間を計測します。

ブート時間は、 NVM の種類やコンフ ィギュレーシ ョ ン、 セキュ リ ティ、 およびイ メージのサイズによって異なり ま
す。 ブート時間の概算が必要な場合は、 ザイ リ ンクスの FAE (フ ィールド  アプリ ケーシ ョ ン エンジニア) へお問い合
わせください。 ザイ リ ンクス  FAE が Boot Timer Estimator を使用して、 さまざまなコンフ ィギュレーシ ョ ンの概算を
行います。

プレーンの非セキュア ブート と  RSA Enable がプログラムされた非セキュア ブート では、 結果が異な り ます。 RSA
Enable がプログラムされている場合は、 BIF 内に [pskfile] 属性と  [sskfile] 属性が指定されている必要があ り、 また
FSBL パーティシ ョ ンの認証が必要です。

X-Ref Target - Figure 4-1

図 4-1 : 予想される TRD 出力
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セキュア スト レージに機密性の高いパーティシ ョ ン
をプログラムする
機密性の高い情報を保護するためのも う  1 つの手段と して、Zynq-7000 AP SoC のセキュ リティ境界内にあるセキュア
ス ト レージ (オンチップ メモ リ  [OCM]、 AXI BRAM) に格納する方法があ り ます。 これは、 リ ンカー スク リプ ト また
は Bootgen [load] 属性で指定できます。

DDR ではなく  OCM にパーティシ ョ ンを格納するには、 リ ンカー スク リプ ト を図 4-2 のよ うに変更します。

FSBL は OCM から実行するため、通常、パーティシ ョ ンは FSBL を使用して OCM へロード されるこ とはあ り ません
JTAG モードの場合は、デバイスを ps7_init で初期化できるため、 XMD コマンドを使用して ELF を OCM へロードで
きます。 その他のブート  モードを使用する場合は、 FSBL で U-Boot をロード し、 U-Boot を使用して OCM へ機密性
の高いパーティシ ョ ンをロード します。

OCM は、 高速で安全なス ト レージであるため、 機密性の高いソフ ト ウェアやデータ  パーティシ ョ ンを格納するのに
最適な場所です。 データ  パーティシ ョ ンはコンパイルされていないソフ ト ウェアです。 したがって リ ンカー スク リ
プ トはあ り ません。 OCM 内のデータ  パーティシ ョ ンを特定するには、 BIF ファ イルで [load] 属性を使用します。

X-Ref Target - Figure 4-2

図 4-2 : セキュリテ ィ  キー ド ライバーを  OCM に格納
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第 5 章

高度なキー管理オプシ ョ ン

概要
製造サイ トで Bootgen が使用されます。Bootgen の動作モードには Debug と  Release があ り ます。 この章では、Release
モードで Bootgen を実行する方法について説明します。 Release モードは、 Debug モード とは異なる方法で RSA キー
を使用します。 Debug モードの場合は非公開キーを使用します。 Release モードの場合は、 最終的な BIF の中に公開
キーとパーティシ ョ ンの署名が含まれます。

最新の暗号技術と してはアルゴ リ ズムが主流であ り、 非公開キーの保護には不可欠です。 Bootgen の Release モード
は、 非公開キーの保護に役立ちます。 この非公開キーの保護は、 製造サイ ト で実施されます。 使用したモード
(Debug/Release) に関わらず、 フ ィールドへ出されるエンベデッ ド  デバイスには同じ公開キーと コンテンツが含まれ
ます。

非公開キーを保護する  1 つの方法と して、 エンベデッ ド製品の最終 リ リース時にセキュ リ テ ィ  ス タ ッ フ  (Infosec
group) を利用するこ とが挙げられます。これによって、暗号キーを取り扱う社員数を削減できます。多くの場合、ハー
ド ウェア セキュ リティ  モジュール (HSM) がセキュア エリ ア内で使用されます。HSM は、RSA の 2 種類のキー (非公
開と公開) と署名を生成します。 HSM に格納された非公開キーは決して漏洩しないため、 セキュ リ ティ も強化されま
す。

Boorgen Release モードでは、 Bootgen と も う一つのザイ リ ンクス  ツール (xil_rsa_sign) が HSM と同じ機能を果たし、
ハッシュ と署名を生成します。 この章では、Bootgen と  xil_rsa_sign を使用して、非公開キーの保護をさらに強化する
方法について説明します。

xil_rsa_sign をコンパイルする際には、 ug1025/zc702_secure_key/xil_rsa_sign_src ディ レク ト リへ移行します。 Linux の
場合は、 makefile_linux を makefile にコピーします。 Windows の場合は、 makefile_xp を makefile にコピーし
ます。 そして make を実行します。

Windows では、 makefile 内の gcc.exe が正し くない場合に make でエラーが生じます。 $XILINX_EDK ソフ ト ウェアには
gcc.exe ファイルが多数あります。 Windows を使用しているときは、 $XILINX/gnu/MinGW/5.0.0/nt/bin/gcc.exe ま
たは cygwin gcc.exe への完全なパスを使用して makefile を編集してください。

CC=c:/cygwin/bin/gcc.exe

または

CC=c:/Xilinx/14.6/ISE_DS/SE/gnu/MinGW/5.0.0/nt/bin/gcc.exe

Bootgen の Release モードを使用する手順を次に示します。システムは、 ug1025/zc702_secure_key ディ レク ト リにあ り
ます。

1. 次のコマンド と  BIF を使用して SPK のハッシュを生成します。

bootgen -image spk.bif -generate_hashes

spk.bif は、 次のとおりです。

spk:
{
[spkfile] spk.pk1
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}

Bootgen が SPK ハッシュ  ファ イル (spk.pk1.sha256) を生成します。

2. xil_rsa_sign を使用して署名を生成します。

xil_rsa_sign -gensig -sk psk.pk1 -data spk.pk1.sha256 -out spk.pk1.sha256.sig

3. 次の Bootgen コマンドを使用して、 パーティシ ョ ンのハッシュを生成します。

bootgen -image bootimage_partitions.bif -o temp.txt -encrypt efuse -generate_hashes

BIF は次のとおりです。

bootimage_partitions:
{
[ppkfile] ppk.pk1
[spkfile] spk.pk1
[spksignature] spk.pk1.sha256.sig
[bootloader, encryption=aes, authentication=rsa] fsbl.elf
[encryption=aes, authentication=rsa] system.bit
[authentication=rsa] u-boot.elf
}

パーティシ ョ ンのハッシュが生成され、ハッシュ  ファ イルは、fsbl.elf.0.sha256、system.bit.0.sha256、
および u-boot.elf.0.sha256 とな り ます。

4. 作成されたハッシュの署名を生成します。

xil_rsa_sign -gensig -sk ssk.pk1 -data fsbl.elf.0.sha256 -out fsbl.elf.0.sha256.sig

xil_rsa_sign -gensig -sk ssk.pk1 -data system.bit.0.sha256 -out 
system.bit.0.sha256.sig

xil_rsa_sign -gensig -sk ssk.pk1 -data u-boot.elf.0.sha256 -out 
u-boot.elf.0.sha256.sig

5. 次の Bootgen コマンドを使用して、 イ メージを生成します。

bootgen -image bootimage_presign.bif -o zc702_uboot_rm.mcs -encrypt efuse

BIF は次のとおりです。

bootimage_presign:

{

[aeskeyfile] efuse.nky
[ppkfile] ppk.pk1
[sskfile] spk.pk1
[spksignature] spk.pk1.sha256.sig
[bootloader, encryption=aes, authentication=rsa, presign=fsbl.elf.0.sha256.sig] 
fsbl.elf
[encryption=aes, authentication=rsa, presign=system.bit.0.sha256.sig] system.bit
[authentication=rsa, presign=u-boot.elf.0.sha256.sig] u-boot.elf
}

6. Bootgen の Debug モード と  Bootgen の Release モードが同じイ メージ ファ イルを生成しているこ とを確認します。
これを行うには、 Bootgen Debug モードでイ メージを生成し、 2 つのイ メージを比較します。次の Bootgen コマン
ドを使用して、 Debug モードで Bootgen を実行します。

bootgen -image bootimage_dm.bif -o zc702_uboot_dm.mcs -encrypt efuse

bootimage_dm.bif は次のとおりです。
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bootimage_dm:
{
[aeskeyfile] efuse.nky
[pskfile] psk.pk1
[sskfile] ssk.pk1
[bootloader, encryption=aes, authentication=rsa] fsbl.elf
[encryption=aes, authentication=rsa] system.bit
[authentication=rsa] u-boot.elf
}

次を実行します。

diff zc702_uboot_dm.mcs zc702_uboot_rm.mcs

これで、 2 つのファイルが同じであるこ とを確認できます。

本章のまとめ

• RSA の安全性は、 公開 (非公開ではない) キーを使用するフ ィールド  デバイスに基づいており、 このキーは必要
に応じて変更できます。

• Bootgen の Release モードは、 製造サイ トで内部攻撃から非公開キーを守るためのオプシ ョ ンです。
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第 6 章

マルチブート

概要
オリ ジナル イ メージのブートに失敗した場合、 Zynq®-7000 All Programmable SoC (AP SoC) を既知の正常な状態へ確
実にブートするためにマルチブートが使用されます。この章では、マルチブート を使用する方法について説明します。

マルチブートでは、 3 つのイ メージを使用します。 FSBL パーティシ ョ ンのみ含むオリジナル イ メージは 0x0 に配置
されています。標準/アップデート  イ メージは 0x400000 に配置されています。そしてゴールデン イ メージは 0xA00000
に配置されています。

マルチブート例の主な構成要素は、 ブートの失敗を引き起こすエラーを定義しています。 この例では、 system.bit
内にエラーが含まれています。

マルチブートは、 次の手順で実行されます。

1. FSBL、 アップデート  イ メージ、 およびゴールデン イ メージを生成します。

bootgen -image bootimage_fsbl.bif -o fsbl.bin -encrypt efuse
bootgen -image bootimage_update.bif -o update.bin -encrypt efuse
bootgen -image bootimage_golden.bif -o golden.bin -encrypt efuse

2. update.bin をコピーして、 アップデート  イ メージのオリジナル版を保存します。

cp update.bin update.bin$

3. アップデート  イ メージ内にエラーを挿入するため、 HEX エディ ター (gvim または hd など) を使用します。

gvim update.bin

4. update.bin にエラーを挿入します。ビッ ト ス ト リームの開始位置は 0x194C0 です。19570 行目の 1 文字を変更
します。 update.bin を保存します。

5. diff コマンドを使用して、 update.bin にエラーが含まれているこ とを確認します。

diff update.bin update.bin$

6. Tera Term を開きます。 [File] → [Log] をク リ ッ ク します。 ダイアログ ボッ クスに 「multiboot.log」 と入力
します。

7. ug1025/zc702_multiboot/ready_for_download から、 BOOT.bin、 fsbl.bin、 update.bin および golden.bin を
SD カードへコピーします。 ZC702 評価ボードでブート  モードを SD に設定します。 電源を一旦切ってから再度
オンにします。

8. U-Boot のプロンプ ト画面で次のコマンドを入力します。

mmcinfo
fatload mmc 0 0x100000 fsbl.bin
sf probe 0 0 0
sf write 0x100000 0 0x20000
fatload mmc 0 0x100000 update.bin
sf write 0x100000 0x400000 ${filesize}
fatload mmc 0 0x100000 golden.bin
sf write 0x100000 0xA00000 ${filesize}
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9. 電源を切り ます。 ブート  モードを SD から  QSPI へ変更します。 電源を入れます。

10. multiboot.log を読み込んで、 マルチブート動作を検証します。

multiboot.log 内で、update.bin のロード  エラーの原因となるエラーが予想どおりであ り、golden.bin イ メー
ジがロード されているこ とを確認します。
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第 7 章

データ  パーティシ ョ ンのローディング

概要
Bootgen は、ELF や BIT ファ イルのほかにもデータ  パーティシ ョ ンをロードできます。代表的なデータ  パーティシ ョ
ン アプリ ケーシ ョ ンには、 デジタル信号処理 (DSP) 係数、 保健記録、 財務記録があ り ます。 ELF、 BIN、 および BIT
などのパーティシ ョ ン タイプと同じよ うに、 Bootgen の属性でデータ  パーティシ ョ ンを暗号化/認証できます。

データ  パーティシ ョ ンをロードする  BIF は、 次のよ うにな り ます。

image:{
{
[bootloader, encryption=aes, authentication=rsa] fsbl.elf
[encryption=aes, authentication=rsa] hello.elf
[encryption=aes, authentication=rsa, load=0xFFFFC000] coefficients.bin
}

このデータ  ファ イル例 (coefficients.bin) には、 0101010111001100 が含まれています。

データ  ファ イルが OCM にロード されているかを確認するには、 次の XMD コマンドを実行します。

mrd 0xFFFFC000 8

一般的に、 データ  パーティシ ョ ンの格納場所と しては OCM が最適です。 上記の BIF に問題はあ り ませんが、 FSBL
が OCM から実行するため、 FSBL を使用してパーティシ ョ ンを OCM へロードすべきではあ り ません。 データ  パー
ティシ ョ ンを OCM へロードするには、 U-Boot を使用する方法を推奨しています。
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第 8 章 : 認証証明のユーザー定義フ ィールドを使用
第 8 章

認証証明のユーザー定義フ ィールドを使用

概要
RSA を使用する場合は、[authentication] 属性がある各パーティシ ョ ンに認証証明 (AC) が生成されます。AC には、キー
や署名のほかに、ロード されるソフ ト ウェアのバージ ョ ンを示すために使用できるユーザー定義フ ィールド  (UFD) が
含まれます。 この UDF は、 パーティシ ョ ン サプライヤーの識別やタイム スタンプ情報の提供など、 さまざまなユー
ザー定義機能に使用できます。

UDF は、 HEX ファ イルで定義されます。 HEX ファ イルのサイズは最大 56 バイ トです。 UDF 内の情報を使用するに
は、 FSBL または U-Boot にコードを追加する必要があ り ます。

AC に UDF を作成する手順は次のとおりです。 完成プロジェク トは、 ug1025/zc702_udf にあ り ます。

1. 16 進数を使用する  uboot_v10.hex を生成します。たとえば、16 進数値と して 「12345678abcdef」 を使用します。

2. udf_data 属性を使用して、 次のよ うに BIF を生成します。

the_image
{
[pskfile] psk.pk1
[sskfile] ssk.pk1
[aeskeyfile] efuse.nky
[bootloader, authentication=rsa, encryption=aes] fsbl.elf
[authentication=rsa, udf_data=uboot_v10.hex] u-boot.elf
}

3. 次の Boorgen コマンドを実行します。

bootgen -image bootimage.bif -o zc702_udf.mcs -encrypt bbram
Zynq AP SoC のセキュア ブート  スタートアップ ガイド japan.xilinx.com 45
UG1025 (v1.0.1) 2014 年 3 月 18 日 Send Feedback

http://japan.xilinx.com
http://japan.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1025&Title=Zynq-7000%20All%20Programmable%20SoC%20%26%2312398%3B%26%2312475%3B%26%2312461%3B%26%2312517%3B%26%2312450%3B%20%26%2312502%3B%26%2312540%3B%26%2312488%3B%20%26%2312473%3B%26%2312479%3B%26%2312540%3B%26%2312488%3B%26%2312450%3B%26%2312483%3B%26%2312503%3B%20%26%2312460%3B%26%2312452%3B%26%2312489%3B&releaseVersion=1.0.1&docPage=37


第 8 章 : 認証証明のユーザー定義フ ィールドを使用
4. HEX エディ ター (gvim または hd) を使用して UDF を特定します。図 8-1 では、0025480 行目に完成した zc702_udf
デザインの UDF を示しています。

X-Ref Target - Figure 8-1

図 8-1 : 認証証明のユーザー定義フ ィールド
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付録 A : その他のリソース
付録 A

その他のリソース

ザイリンクスのリソース
アンサー データベース、資料、 ダウンロード、 フォーラムなどのサポート  リ ソースを利用するには、次のウェブサイ
トにアクセスして ください。

japan.xilinx.com/support

常に最新情報を受け取るには、 マイ  プロフ ィールからアラートにアンサーを追加してください。

japan.xilinx.com/support/myalerts

ザイ リ ンクスの資料で使用されている技術用語については、 次の用語集を参照して ください。

japan.xilinx.com/company/terms.htm

ソリューシ ョ ン センター
デバイス、 ツール、 IP のサポートについては、 ザイ リ ンクスのソ リ ューシ ョ ン センターを参照してください。設計に
関するアシスタンス、 アドバイス、 問題解決のヒン ト などを記載しています。

参考資料
ZC702 および関連資料の最新情報は、 次のウェブサイ トから入手できます。

Zynq-7000 All Programmable SoC ZC702 評価キッ トのウェブサイ ト

Zynq-7000 All Programmable SoC ZC702 評価キッ トの資料ウェブサイ ト

これらのザイ リ ンクス資料およびウェブサイ トでは、 このユーザー ガイ ドで役立つ情報を提供しています。

1. 『Zynq-7000 All Programmable SoC ZC702 評価キッ トおよびビデオ/画像処理キッ ト  スタート アップ ガイ ド』
(UG926)

2. 『Zynq-7000 All Programmable SoC のセキュア ブート 』 (XAPP1175)

3. 『Zynq7000 XC7Z020 All Programmable SoC 向け ZC702 評価ボード  ユーザー ガイ ド』 (UG850)

4. 『Zynq-7000 All Programmable SoC : コンセプ ト、 ツール、 テクニッ ク  ガイ ド』 (UG873)

5. 『AMS101 評価カード  ユーザー ガイ ド』 (UG886)

6. 『Zynq-7000 All Programmable SoC テクニカル リ ファレンス  マニュアル』 (UG585)
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http://japan.xilinx.com/support/documentation/application_notes/j_xapp1175_zynq_secure_boot.pdf
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7. 『Zynq-7000 All Programmable SoC ソフ ト ウェア開発者向けガイ ド』 (UG821)

8. Tera Term のウェブサイ ト  : en.sourceforge.jp/projects/ttssh2/releases/

9. Silicon Laboratories 社の USB-UART ド ラ イバー ウェブサイ ト  :
www.silabs.com/Support%20Documents/Software/CP210x_VCP_Windows.zip
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付録 B : Warranty

付録 B

Warranty
THIS LIMITED WARRANTY applies solely to standard hardware development boards and standard 
hardware programming cables manufactured by or on behalf of Xilinx (“Development Systems”). 
Subject to the limitations herein, Xilinx warrants that Development Systems, when delivered by Xilinx or 
its authorized distributor, for ninety (90) days following the delivery date, will be free from defects in 
material and workmanship and will substantially conform to Xilinx publicly available specifications for 
such products in effect at the time of delivery. This limited warranty excludes: (i) engineering samples or 
beta versions of Development Systems (which are provided “AS IS” without warranty); (ii) design 
defects or errors known as “errata”; (iii) Development Systems procured through unauthorized third 
parties; and (iv) Development Systems that have been subject to misuse, mishandling, accident, 
alteration, neglect, unauthorized repair or installation. Furthermore, this limited warranty shall not apply 
to the use of covered products in an application or environment that is not within Xilinx specifications or 
in the event of any act, error, neglect or default of Customer. For any breach by Xilinx of this limited 
warranty, the exclusive remedy of Customer and the sole liability of Xilinx shall be, at the option of 
Xilinx, to replace or repair the affected products, or to refund to Customer the price of the affected 
products. The availability of replacement products is subject to product discontinuation policies at 
Xilinx. Customer may not return product without first obtaining a customer return material authorization 
(RMA) number from Xilinx.

THE WARRANTIES SET FORTH HEREIN ARE EXCLUSIVE. XILINX DISCLAIMS ALL OTHER WARRANTIES,
WHETHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT, AND ANY WARRANTY
THAT MAY ARISE FROM COURSE OF DEALING, COURSE OF PERFORMANCE, OR USAGE OF TRADE. (2008.10)

Do not throw Xilinx products marked with the “crossed out wheeled bin” in the trash. Directive 
2002/96/EC on waste electrical and electronic equipment (WEEE) requires the separate collection of 
WEEE. Your cooperation is essential in ensuring the proper management of WEEE and the protection of 
the environment and human health from potential effects arising from the presence of hazardous 
substances in WEEE. Return the marked products to Xilinx for proper disposal. Further information and 
instructions for free-of-charge return available at: http:\\www.xilinx.com\ehs\weee.htm.
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